
Select Content 
for Editing 
I n order for Elements to know what portion of an

image you want to repair or retouch, you need to
make a selection within the appropriate layer. You

can, of course, simply activate a specific layer without
making a selection, which enables you to apply retouching
tools or filters to the entire layer; but many times you will
want to restrict the effects of a tool or filter to a specific
area within the layer. You can make such a selection with

one or more of the four selection tools: Marquee, Lasso,
Magic Wand, and Selection Brush. After making the
selection, you can apply filters or tools that lighten, darken,
blur, or sharpen the content within the selection, as well as
change colors and color values. After completing the
retouching, you can remove the selection by pressing
Ctrl+D (or Command+D if you use a Mac) and move on to
select and restore another area of the image.

2

Background

1

1 Click to activate the layer you want to restore,
retouch, or repair.
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Select Content for Editing

2 Click the Marquee, Lasso, Magic Wand, or
Selection Brush.

Choose the selection tool you feel most
comfortable with — the one with which you
can be the most accurate and exacting — so
that only the content you want to repair is
selected. 
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The area I need to
select is very small.
How do I select it
quickly?

You can zoom in very
tight and then use the
appropriate selection
tool: a Marquee or
Polygonal Lasso tool
for a selection with
straight sides, or the
Lasso or Selection
Brush for a free-form
selection. 

How do I select
everything but a
particular area
within a layer?

Select the area you
want to preserve,
and then choose
Select➔Inverse. This
command selects
everything on the
active layer except
for the content you
originally selected.

Can I select and then
retouch content on
more than one layer
at a time?

No. You can, however,
merge linked layers
into one layer and then
apply your changes.
The drawback to this
approach is that you
can no longer edit
the content from the
separate layers
individually: that
content remains on
a single layer after
you complete your
retouching or
restoration.

3 Drag to make the selection you need. 

A dashed line appears around the
selection.

Note: You can use multiple selection tools
along with the Add to and Subtract
from tools to make a specialized
selection. 

3
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Retouching with 
the Clone Stamp
T he Clone Stamp is one of the most commonly used

tools in restoring and repairing images. With this
tool, you can clone (duplicate) content from one

part of an image and cover unwanted or damaged areas
somewhere else in the same image or in a different image.
The cloning process involves holding down the Alt (Option)
key to sample the donor location, or the content area that
represents the best choice to use for covering the unwanted
portion of the image. After sampling the donor content,
you can then click to apply the cloned content wherever it

is needed. You can cover scratches, stains, rips, and tears.
You can even cover an entire person, something in the
background, objects in the foreground, or anything else
you no longer want to see in the image. Cloned content
becomes part of the active layer, rather than inhabiting a
new layer by itself. The Clone Stamp offers several options
for controlling the cloned area and the method of
application, including several brush-based tools that
establish the brush preset, size, and the opacity of the
cloned content.

1

5

Background

3
4

2

1 Click the Clone Stamp tool ( ).

The Clone Stamp options bar appears.

2 Adjust the brush preset and size.

3 Click to select the layer containing the
content to be cloned.

4 Locate the content you want to clone.

226

Retouching with the Clone Stamp

5 Press the Alt (Option) key and click the
donor content.

The mouse turns into cross hairs as you
sample the content to be cloned.
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What size brush preset should
I use?

Avoid any brush that is either
too big or too small. A large
brush may clone more than you
want, making fine repairs much
harder. A small brush may
require you to clone and stamp
many times to cover the
unwanted content. Measure the
width and height of the area to
be covered, and pick a brush
that is roughly one-quarter the
size so that you can cover the
area in only four clicks.

My cloned content looks very
obvious. How do I make it blend
in with the surroundings more
smoothly?

When covering a large area with
cloned content, resampling fresh
content can help avoid the look
of a pattern, or an unnatural
repetition in textures. You can
also turn off the Align option, so
that Elements will follow your
mouse and continuously
resample nearby pixels — this
avoids the look of a repetitive
pattern because the cloned
content is taken from a new spot
each time you click the mouse.

How do I clone content from
one image to another?

The only difference between
cloning between separate
images and cloning within a
single image is where you click
after you have created the clone.
Press the Alt key and click to
clone the source image, and
then click within the target
image to place the cloned
content. 

6 Click to place the cloned content elsewhere in
the image.

The cloned content covers pixels in the active
layer.

Note: If you want to place your cloned content in
another image, make sure that image is open,
and then just click within the image to place
the donor content where it is needed.

6

7
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7 Continue clicking to place cloned content in
the image.

Note: You can resample as many times as you need,
cloning a new area to deposit in other
locations in the image.
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Restore with the 
Healing Brush
L ike the Clone Stamp, the Healing Brush enables you

to copy donor content from one spot of the image
to another, covering unwanted content. However,

Elements adjusts the color and lighting of the cloned
material to match the location where you place the donor
content. For example, you can sample an area of wallpaper
in a group photo and place the sample on the other side of
the photo, even if that side is in shadow or more brightly lit
than the side where you sampled the donor content.

Elements adjusts the color and light levels to match the
new environment, creating a more seamless effect than
you might achieve with the Clone Stamp. The Healing
Brush’s options include several of the same tools as the
Clone Stamp, and offer the ability to sample content from
the image (using the Source option), or to instead place a
selected pattern over the unwanted content. Again, the
pattern will be recolored and relit to match the surrounding
pixels. 

2

1

70 px

1 Click the Healing Brush tool ( ).

The Healing Brush options bar appears.
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Restore with the Healing Brush

2 Click here to select a brush preset.
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What does the Spot Healing Brush do?

The tool’s name says it all: the Spot Healing
Brush fixes small spots with a single click.
It also enables you to heal with a proximity
match (in which the healing content alters
to match the surrounding pixels), or to
create a texture. The Spot Healing Brush is
your best bet when you need to mask tiny
imperfections rather than large areas of
unwanted or damaged content.

Are there any drawbacks to using the
Healing Brush instead of the Clone
Stamp?

No, unless you do not want the content
that covers the unwanted content to stand
out. If you want to place content from
elsewhere in the image over the unwanted
content — with new colors, different
lighting, and different textures — you must
use the Clone Stamp, which does nothing
to force the cloned content to match its
new surroundings. If you want a more
seamless and invisible repair, use the
Healing Brush.

3 With Sampled selected by default, press the
Alt (Option) key.

The mouse pointer turns into cross hairs.

4 Click to sample the area that will be used to
heal another area.

4

5
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5 Click to place the healing content over
unwanted content.

The unwanted content is covered.

Note: You will experience a momentary pause before
the healing content is recolored and relit to
match the surrounding pixels.

6 Repeat steps 3 to 5 to heal any other damage
or unwanted content.
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Make Automatic 
Corrections
E lements was designed to make the power of

Photoshop more affordable and more accessible for
home- and small-business users. Now anyone can

make quick corrections to photos by using Elements’ many
Auto tools. You can adjust lighting, color, and contrast with
just a few menu commands. You can perform the
automatic corrections one at a time, focusing on the most
obvious problems and restricting the effects to selected
areas of the image; or you can make sweeping changes to
the entire image and adjust several problems at once. The
Auto correction tools, accessed through the Enhance menu,

include Auto Smart Fix (which fixes multiple problems at
once); Auto Levels (another tool for making changes to
overall image quality); Auto Contrast (which adjusts the
balance of light and dark); and Auto Color Correction.
None of the four commands have an associated dialog box.
Instead of tweaking the parameters yourself, the commands
use default settings for light and color and the adjustments
are based on your image and its pixels in their current state.
You can adjust the way Smart Fix works, however, by using
the Adjust Smart Fix dialog box. 

1

2

3
4Enhance

Auto Smart Fix                              Ctrl+M

1 Click a selection tool.

230

Make Automatic Corrections

2 Select the area to be automatically
corrected.

Note: If your image has problems throughout,
you can skip steps 1 and 2 and perform
step 3 with no selection in place.

3 Click Enhance.

4 Click the Auto correction command of
your choice.

The automatic correction is applied.
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Here, a photo in need of overall
improvements in light levels has been
corrected with Smart Fix.

3

4

152

•
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3 Drag to the right to increase the
amount of correction achieved by
Smart Fix.

Observe the image window for changes.

• The Preview option must be on in
order to see the image change as
you drag the slider.

4 Click OK to apply the change.

Adjust Smart Fix

1 Click Enhance.

2 Click Adjust Smart Fix.

The Adjust Smart Fix dialog box opens. 

When I apply an automatic
correction command, why do I
not see a big difference in my
image?

The automatic correction 
tools — Auto Levels, Auto Smart
Fix, Auto Contrast, and so 
on — are set to a general range
of adjustments so that not too
much light or shadow is added,
and so that colors are not
drastically changed. If the
lightness or darkness, contrast,
and colors in your image are
relatively normal, you may not
see a major change in the
image, even after applying an
Auto correction.

How do I know which automatic
correction command to use?

Your choice of the four
automatic corrections — Smart
Fix, Levels, Contrast, and
Color — is dictated by the
problems you are having with
your image. If your image has
a green or red cast (the two
most common color casts), or
if it has faded and become
yellowed with age, choose Color
Correction. If your light areas
are blindingly bright and detail
is lost to an overzealous flash,
choose Contrast. Smart Fix and
Levels adjust color and lighting
levels, and can be used for
images with multiple problems. 

What is the default
“Fix Amount” setting 
for Smart Fix?

In the Adjust Smart Fix dialog
box, click the Auto button to set
the Fix Amount to 100%. This
setting is located in the middle
of the slider’s range, and
provides exactly half the level of
adjustment that the maximum
(200%) provides.
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Apply a 
Quick Fix
Q uick Fix enables you to make multiple changes to

your image. When you click the Quick Fix button,
a series of palettes appears on the right-hand side

of the window. Through these palettes, you can rotate the
image, adjust the lighting, color, and sharpness, or
simultaneously apply and adjust Smart Fix settings. As you
drag the various sliders, you see the changes reflected in
your image; if an adjustment is undesirable, you only need
to drag the slider in the opposite direction, or use the Undo
History palette (or Edit, Undo) to reverse the adjustment. 

Of course, not all aspects of an image require adjustments.
You may find that the lighting of your image is fine, but
that the color may need some tweaking. You may also find
that your image has so many problems that you need to
adjust most if not all of the Quick Fix sliders to improve the
lighting, color, and detail. After you have made all the
changes you need, you can return to the default Standard
Edit mode by clicking the Standard Edit button. 

1
1 Click the Quick Fix button.

The workspace changes, showing an
After version of the image, and four
new palettes on the right side of the
workspace.

Note: The After version is really the Before
version until you drag any of the sliders
in the palettes on the right side of the
workspace.
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Apply a Quick Fix
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How is Quick Fix different than Smart Fix?

Smart Fix is a simple tool that adjusts the
overall light and color values in an image.
Quick Fix does the same thing, but gives
you more control over the process by
offering four palettes that affect very
specific image attributes. Through the use
of sliders, you can make very precise
adjustments to some or all of the settings;
the Adjust Smart Fix slider, on the other
hand, only allows you to change the degree
of overall adjustment.

How do the Temperature and Tint
settings affect my image?

Color images are often described as being
“hot” or “cold,” depending on the amount
of warm reds and oranges or cool blues
and greens. You can change the visual
temperature of your image by dragging the
slider to the right to warm the image, or to
the left to cool it. The Tint slider adds either
more pink or more green (opposites on the
color wheel), and can be used to overcome
an undesirable color cast.

2 Observe your photo and decide what
settings need to be adjusted.

• This photo is in need of a higher
level of contrast and brighter color.

4

•

3
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3 Drag the appropriate sliders, one at
a time.

Watch the image window to see if the
desired results are achieved.

4 To use the default settings for any of
the sliders, click the Auto button.

17_578782 ch10.qxd  3/21/05  11:32 AM  Page 233



Fix an Underexposed 
Image
Y ou can use blending modes and layers to build and

improve image lighting in underexposed images.
Underexposed images are typically identified as

having very poor lighting, such as a photo in which the
camera’s flash did not work properly, or the overall lighting
conditions were too poor for good picture taking. Although
you cannot always restore badly underexposed photos to
perfection, you can apply Photoshop Elements blending
modes and layers to vastly improve the exposure problem.
The Multiply blending mode creates intense, dark colors,
while the Screen mode lightens colors by blending them.
By combining the two modes, you can modify the light in
an image. 

You use blending modes in conjunction with Levels
Adjustment layers to fine-tune the light and dark tones in
an underexposed image. You may need to experiment with
the number of layers and blending modes to achieve the
right effect for your own images.

The first step is to create several adjustment levels, and then
assign the blending modes to the different levels to correct
the underexposure, one layer at a time. Since layers are
stacked, each mode you apply affects the pixels in the
underlying layers.

Levels 3

Levels 1

Multiply

3

1

2

1 Add three Levels Adjustment layers to the
Layers palette.

Note: Your own photo may require more or fewer
Adjustment layers and blending modes to
achieve the look you want. 

Note: For more about adding layers, see Chapter 6.
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Fix an Underexposed Image

2 Click the first Adjustment layer.

3 Click here and then click Multiply.

The Multiply mode multiplies the image’s
base colors, resulting in more intense, darker
colors.
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Can I use the Brightness and Contrast feature to
fix an exposure problem?

Although the name implies corrections for image
brightness, the Brightness and Contrast filter does
not necessarily correct overly light or overly dark
images. Raising brightness values in an image makes
all the pixels lighter, while lowering the values
makes all the pixels darker. For most photos, you do
not need to adjust all the pixels, just those affected
by the exposure problem. See the section “Control
Brightness and Contrast” for more about the
Brightness and Contrast filter.

How do I fix an overexposed photo?

Depending on the amount of overexposure, you
can use the Levels dialog box to make adjustments
to the midtones, shadows, and highlights in your
photo. By subtracting light from the image,
you can make subtle corrections to an overexposed
snapshot. The Photoshop Elements Levels command
is one of the handiest features for adjusting light
levels in an image. See the section “Adjust Image
Levels” for more information.

4 Click the second Adjustment layer.

5 Click here and then click Screen.

The Screen mode produces a lighter overall
color by blending the layers.

Levels 2Screen
4

5

7

8

6
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6 Double-click the third Adjustment layer’s
Levels thumbnail.

The Levels dialog box opens.

7 Drag to lighten the image.

8 Click OK.

Photoshop Elements applies the adjustments.

Note: You may need to tweak different settings to
create the desired effect for your photo.
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Add Light with 
the Dodge Tool
U nlike adjustment tools that require input from

dialog boxes, sliders, and menu commands, the
Dodge and Burn tools, found in the Editor

workspace toolbox, enable you to drag your mouse across
an image and adjust the color and light manually. The first
of these tools to be discussed here, the Dodge tool, works
by increasing the amount of light in the image. When you
use the Dodge tool, you can select the size of the brush
from the options bar; and with Range and Exposure settings
unique to the Dodge and Burn tools, you can determine
the intensity of the results and what areas of the image will

be affected: the current shadows, highlights, or midtones.
If you do not want any changes to occur outside a specific
problem area, you can confine the effects using the Layers
palette and any of the selection tools. After you have
chosen an area to lighten, you can drag the Dodge tool
over the image to add light as needed. You can drag over
an area once, or click with a large brush to apply a subtle
degree of light or shadow to one spot. You can also drag
repeatedly over an area, adding more and more light,
until you achieve the desired results.

Midtones

2

1
3

1 Click the Dodge tool ( ).

The Dodge tool options bar appears.

Note: The Dodge tool shares a button with the Burn
and Sponge tools. You can switch between
the tools using the first three buttons on the
options bar. 

2 Click to select a brush preset.

Note: Choose a soft-edged brush to avoid obvious
delineation between dodged areas and
nondodged areas.
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Add Light with the Dodge Tool

3 Click the Range list to choose from Shadows,
Highlights, or Midtones.
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The Dodge tool lightens the pixels in the
path of the mouse. What is the origin of
the term “Dodge”?

Dodging is an old photographer’s term,
describing the process of reducing the
amount of available light during the print
exposure. This seems contradictory, given
that dodging adds light to the photo; but
reducing the amount of light that falls on
the image as it is printed (using traditional
manual development methods) results in
a lighter image. Burning is the opposite:
Light is added during exposure, resulting
in a darker image.

Applying the Dodge tool seems to wash
out my colors. Why?

Adding light really means adding white
pixels to the image as you drag your
mouse within the image window. By
adding white pixels, you lose some of the
colored pixels, which gives your colors
the washed-out look.

4 Click here to activate and drag the Exposure
slider.

The higher the Exposure setting, the more
intense your results will be.

4

5
•
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5 Drag within your image.

• The Dodge tool lightens the pixels in the
path of your mouse. 
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Darken with 
the Burn Tool
T he Burn tool is the Dodge tool’s opposite. It works

by increasing the amount of black in the image,
thus increasing the darkness. When you use the

tool, select the size of the brush from the options bar and
then adjust the Range and Exposure settings to determine
the intensity of the results and what areas of the image
will be affected. Like the Dodge tool, your areas are the
shadows, highlights, or midtones, and also like the Dodge
tool, you can restrict the Burn tool’s effects to one area by

using a selection tool first. After establishing an area to
darken, drag the Burn tool over the image to add darkness
wherever it would help the image quality. You can drag
over an area once to darken it, or drag over and over to
achieve greater levels of darkness. You can also click with a
large brush to apply a shadow to one spot — but for best
results, use a soft-edged brush or a brush that is larger than
the selection so that the brush edges are not obvious. 

2

1
3

Midtones

1 Click the Burn tool ( ).

The Burn tool options bar appears.

2 Click to select a brush preset.

238

Darken with the Burn Tool

3 Click the Range list to choose from Shadows,
Highlights, or Midtones.
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How can I prevent the Burn tool from
darkening the white areas of my image?
I only want the colored areas to be
darkened.

If you select the white pixels with the Magic
Wand before using the Burn tool, dragging
over those pixels only affects the adjacent
and unselected colored pixels.

How do I know what Range to choose for
the Dodge or Burn process?

The Range option enables you to confine
your adjustment to the lightest pixels
(Highlights), the darkest pixels (Shadows), or
to those pixels that fall in the middle of the
spectrum of light to dark (Midtones). To
make a change that affects the entire image,
choose Midtones. To heighten the light
values of the pixels that are already light,
choose Highlights when using the Dodge
tool. To make shadows even deeper, choose
Shadows when using the Burn tool.

4 Click here to activate and drag the Exposure
slider.

The higher the Exposure setting, the more
intense your results will be.

4

5
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5 Drag within your image.

The area where you drag becomes darker.
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Correct Shadows 
and Highlights
T he Shadows/Highlights dialog box has three sliders that

enable you to increase the levels of light, dark, and
midtones (pixels falling in the middle of the range from

very light to very dark), and to view the effects of your adjustments
in the image window. The nature of your image and the area you
may have selected determine which sliders are appropriate. For
example, if your image is very light — as from too much sunlight
or too much flash when the picture was taken — you can drag the
Darken Highlights slider to the right. Conversely, if your image is
too dark, you can drag the Lighten Shadows slider to the right,
making the shadows less stark. The Midtone Contrast slider helps
the pixels that are neither shadows nor highlights stand out from
one another, increasing (if you drag to the right) or decreasing
(if you drag to the left) their differences.

4

5

3

•
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Correct Shadows and Highlights

1 Click Enhance, Adjust Lighting.

2 Click Shadows/Highlights.

The Shadows/Highlights dialog box appears.

3 Be sure the Preview check box is checked.

4 Drag to adjust the image.

• You can drag the dialog box out of the
way to see the image window. 

5 Click OK.

Elements applies the changes.

Is there any benefit to using Shadows and
Highlights, rather than the Burn and
Dodge tools?

One benefit is that you do not have to drag
the mouse or make a selection before using
the Shadows and Highlights tool. You can
also preview your changes before
committing to them; with the Dodge and
Burn tools, you have to Undo to get rid of
unwanted lightening or darkening. On the
other hand, with the Dodge and Burn tools
you can focus your changes more easily by
zooming in on the image and dragging a
very small brush across a specific area.
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Control Brightness 
and Contrast
B rightness (the amount of white in the image) and contrast (the

degree of difference between adjacent pixels) are both controlled
in a single dialog box. With the Preview setting on, you can drag

the two sliders, watch the results in the image window, and commit to
your changes when you like what you see. Problems with brightness occur
when there is either too much or too little available light when a photo is
taken. Contrast problems occur for similar reasons, but are more a product
of the camera or development technique (in the case of traditional film
cameras) than the lighting in the physical location of the shot. You can
adjust one or both of these values for any image, making big changes by
dragging the sliders all the way to the left or right, or small, subtle
adjustments by making tiny changes in the Brightness and/or Contrast
values. The dialog box offers text fields if you prefer entering specific
values rather than making visual adjustments with the sliders.

5

3

•

4

+57

1 Click Enhance, Adjust Lighting. 

2 Click Brightness/Contrast.

The Brightness/Contrast dialog box opens.

3 Confirm that the Preview check box is
checked.

Control Brightness and Contrast
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4 Drag as needed.

• Watch the values change in the text boxes
accompanying each slider.

5 Click OK.

Why does a reduction in
contrast make my photo
look like it was taken on
a cloudy day?

Because a reduction in
contrast reduces the
difference between your
pixels’ light levels. The
lightest pixels become
darker, and the darkest pixels
become lighter, resulting in
a washed-out look.

The changes seen in the Preview are now
applied to the image.
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Adjust Image 
Levels
Y ou can adjust the range of colors and the values of

light and dark pixels in a photo to produce better
contrast and a more even range of highlights and

shadows. With the Levels dialog box, you can establish the
black, gray, and white point pixels in your image. After
establishing these extremes (the darkest pixel is the black
point, the lightest is the white point, and the pixel that
represents the middle of that range is the gray point),
Elements adjusts all the pixels in the image to fall

appropriately within the defined range. You do not have
to reset all three points; if you want to adjust just the
midtones and shadows, for example, you can reset a gray
point and a black point and nothing else. The Levels dialog
box also enables you to fix color casts as you click to set
the points in a color image; depending on what pixels you
click, you can make an image warmer by adding a red
or orange cast, or cooler by adding a blue or green cast. 

3

7

6

5

9
8

4

•

1 Click Enhance, Adjust Lighting.

2 Click Levels.

The Levels dialog box opens.

Default levels are displayed in the dialog box.

3 Be sure the Channel is set to RGB to ensure that your
changes apply to all the colors in your image.

Note: If your image is grayscale, only a Gray channel is
available.

4 Click the Set Black Point button ( ).

5 Click the darkest pixel in your image.

The Black Point is set, and the Input level changes.

6 Drag the Shadow slider to adjust the setting.

7 Click the Set White Point button ( ).

8 Click the lightest pixel in the image.

• The White Point is set, and the Input level changes.

9 Drag the Highlight slider to adjust this setting.

Observe the changes in your image, as the pixels are
adjusted overall to fall within the new standards for
darkest and lightest.
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Adjust Image Levels
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What if I am not able to tell which are
my darkest and lightest pixels?

You can see which areas of the image will
be set to black or white by pressing the Alt
key (if you are using Windows) or the
Option key (if you are using a Mac) as you
drag the Input sliders. When you drag the
Shadow slider (the darkest triangle), the
black areas represent the areas that will be
established as the darkest pixels. As you
drag the Highlight slider (the white
triangle), the white areas represent the
areas that will be established as the
lightest pixels. 

What does the Auto button do?

Clicking the Auto button is the same
as using the Enhance➔Auto Levels
command. The default settings for dark,
light, and midtone pixels apply to the
image automatically.

0 Click the Set Gray Point button ( ).

! Click on a pixel that falls midway between the lightest
and darkest.

The Gray Point is set. 

• Drag the middle slider (gray triangle) to adjust the
Gray Point.

@ Reset any points to change the Levels of your image.

Note: If you find that your image is too light or too dark,
reset the White and/or Black points. If your image
looks washed out, reset the Gray point.

# Drag the Output slider.

Drag to the right to increase the intensity of the
effects, or to the left to decrease them. 

$ Click OK.

The Levels changes are applied to the image and the
dialog box closes.

$

#

!

•

0
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Add a 
Spotlight
Y ou can use Photoshop Element’s Lighting Effects

filters to create the illusion of spotlights, omni, and
directional lights in an image. Lighting effects are a

good way to create ambiance in your images. You might
add a spotlight to direct focus on a particular object in a
photo. For example, in a crowd scene or group photo, you
can use a spotlight to point out a family member. 

Elements offers 17 different light styles you can try and 3
light types. Spotlights create an elliptical beam of light while
omni lights shine directly over an image. Directional lights

shine light from one angle. You can experiment with all the
available light styles to create different types of lighting
effects on your photos.

After you assign a light style, you can control the direction
of the light source and the focus of the beam. For example,
with the spotlight style, you can control the center point
where the light effect is pointed in the photo. You can
control the light intensity to make the illusion of a spotlight
appear brighter or more subtle in the photo.

Render

Lighting Effects...

Soft Omni

Layer 1

4

5

1

•

2

3

1 Select the layer to which you want to
apply the filter.

Note: For more about layers, see Chapter 6. 

2 Click Filter.

3 Click Render.

4 Click Lighting Effects.

The Lighting Effects dialog box appears.

244

Add a Spotlight 

• Photoshop Elements displays a small
preview of the effect.

5 Click here and then click a lighting style.

Note: Some light styles utilize multiple lights;
you must position each light in the set
and adjust the settings individually.
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What is a lens flare, and how can I add it to
an image?

Lens flare is the extra flash of light that
sometimes appears in a photo when too much
light enters a camera lens. Photographers try
to avoid this effect, but if you want to add it,
you can use the Lens Flare filter. The effect can
make your digital image look more like an 
old-fashioned photograph. To apply the filter,
click the Filter menu; then click Render, Lens
Flare. You can control the brightness of the
effect as well as the position of the flare. 

What do the other Render filters do?

The Render filters category includes a variety
of filters for creating different types of drawing
and texture effects. Lighting Effects, which
creates the illusion of dimensional light
shining on the photo, is one of seven Render
filters. Others include filters for creating cloud
patterns, texture fills, and fibers. The 3D
Transform filter maps selections into 3D cubes,
spheres, and cylinders.

• Optionally, you can click here and click a
lighting type.

6 Adjust the position and shape of the lighting
by clicking and dragging the handles in the
preview window.

• You can click and drag the center point to
change where the light is centered.

7 Drag to control the light intensity.

8 Click OK.

•

•

8

7

6
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Photoshop Elements applies the filter.
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Adding and 
Removing Color
T he Sponge tool enables you to brighten or enliven

colors from scanned images that have faded or
discolored over time. You can also remove color,

which may be handy if any of the colors in a photo are too
bright for your needs; or if, for artistic and aesthetic
reasons, you want to achieve a more muted color effect.
The Sponge tool, sharing a button with the Dodge and
Burn tools, has two modes: Saturate and Desaturate. In
Saturate mode, you can increase the amount of color in all
the pixels in the path of your mouse. You can do this either

on the active layer, or within any selection you may have
made to confine the tool’s results. In Desaturate mode, you
can wash out the color as you drag over the pixels in your
image. In either mode, the Flow control determines the
intensity of the saturation or desaturation. This option is set
to 50% by default, and increasing that percentage creates
more dramatic results. For a subtle effect, set Flow to 25%
or less, and use a soft brush preset to avoid sharp edges
around the areas that have been saturated or desaturated
with the Sponge tool.

1

2

3

Saturate

1 Click the Sponge tool ( ).

The Sponge tool options bar appears.

2 Choose a brush preset and Size.
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3 Click to select Saturate or Desaturate Mode.
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Why are the results of the Sponge tool
so uneven within my selection?

You may be seeing the paths where your
mouse went over the same pixels more
than once. You can avoid this by choosing
a Brush size that is large enough to cover
most or all of the pixels in a single pass.
If your brush is too small, you end up
adding or removing more color in some
areas than in others. 

Does the Sponge tool work in grayscale
images?

Yes, you can use it to create more shades
of gray (in Saturate mode) or fewer
shades (in Desaturate mode), the latter
resulting in an image with a very faded
look. If you work in Saturate mode, the
grays become more diverse, as though
you are increasing the brightness and
contrast in the image.

4 Click here to drag the Flow slider.

Drag to the right to increase the intensity of
the effect.

4

•

•
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5 Within the desired layer and/or selection, drag
your mouse over the image.

• Color is added in Saturate mode.

• Color was removed in Desaturate mode.
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Adjust Hue, Saturation,
and Lightness
T he Hue/Saturation dialog box does the same job

as the Sponge tool, but instead of dragging over
your image’s pixels with the mouse, you use the

Saturation slider to add or remove color levels in the entire
image or within a selection. The Hue slider gives you the
added ability to change the colors within the image. With
a third slider for adjusting lightness, you can add light to
parts of your image or to the entire image. The dialog box
also enables you to focus only on certain colors within your
image; click the Edit list (set to Master, which affects all

the colors at once) to choose from Red, Yellow, Green,
Cyan, Blue, or Magenta. With a single color chosen from
the Edit list, you can drag all three of the sliders and
change just that color; the other colors in the image are
unaffected. The Colorize option turns your entire image to
monochrome, or an image consisting of varying shades
of a single color. With the Colorize option on, you can drag
the Hue slider to pick the color and adjust the level and
amount of that single color and also add light to it. 

3

•

•

1

4
Master                 Ctrl+~

+109

1 Click Enhance, Adjust Color.

2 Click Adjust Hue/Saturation.

• The Hue/Saturation dialog box appears.

248

Adjust Hue, Saturation, and Lightness

3 Click here and select a single color to
adjust.

Set to Master by default, you can also pick
from six individual colors.

4 Drag the Hue slider to change colors.

• When Preview is selected, Elements
shows your changes in the image
window as you make them.
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How do I know what color to
choose from the Edit list?

If your image has a color cast —
perhaps it looks yellowed, or
everyone in a group photo looks
sickly green or flushed red —
choose that undesirable color
from the Edit list and then
reduce the Saturation level for
that color only. You can also
choose a color that you want
to add — such as magenta to
balance green, or blue to
balance yellow — and increase
that color to resolve the
unwanted color cast.

Why would I want to use the
Colorize option?

The Colorize option creates
a monochrome image — an
image made up of varying
shades of a single color. You
may apply this option to just
a single layer, or to only one
part of the image.

How do I use the eyedroppers in
the Hue/Saturation dialog box?

The eyedroppers become active
if you choose a color from the
Edit list (rather than leaving it
set to Master). The first
Eyedropper tool enables you to
click on a spot within the image
to establish the range of colors
to be affected. You can then use
the Add to Sample (+) and
Remove from Sample (-)
eyedroppers to control what
shades within that range are
affected by the sliders. 

5 Drag the Saturation slider to add or
remove color.

6 Drag the Lightness slider to add or
remove light.

More white pixels are added to the
image if you increase Lightness.

7 Click OK.

5

6

7

+59

+34
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The changes shown in the Preview are
now applied to your image.
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Apply Color 
Variations
Y ou can use the Color Variations dialog box to

perform several different color changes with one
tool. The dialog box offers Before and After

previews of your image, so you can see the results before
you commit to your changes; and it enables you to change
four different areas of your image: Midtones, Shadows,
Highlights, or Saturation. You can switch between these
four areas, adjusting two or more of them before
committing to your changes. As you pick an area to adjust,
the thumbnail “buttons” in the #3 section of the dialog box

change, enabling you to increase or decrease the levels of
red, green, and blue or to lighten or darken the overall
image. These buttons are the same for midtones, shadows,
and highlights, but results vary based on the area you
change. Only two buttons/thumbnails are available for
Saturation: Less Saturation and More Saturation. Like the
Increase and Decrease buttons, you can click each button
more than once, intensifying the results with each click. The
Amount slider also enables you to determine the intensity
of your results, no matter what area you are adjusting.

4

3

1 Click Enhance, Adjust Color.

2 Click Color Variations.

The Color Variations dialog box appears.

The dialog box usually covers the image
window, showing the Before and After
thumbnails within the dialog box.

3 Click to select an area to adjust 
( changes to ).
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4 Click a button to make your adjustment.
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Can I use the Color Variations
dialog box to adjust a single layer
or selection in my image?

Yes. Select the layer or make the
selection before opening the dialog
box. Whatever changes you make in
the dialog box (as shown in the After
thumbnail) apply only to the layer or
selection.

Can I use Color Variations on a
grayscale image?

Yes, but you will have limited
functionality within the dialog box.
The Saturation option will not be
available in the first section of the
dialog box; and when you choose
Midtones, Shadows, or Highlights,
you will have only Lighter or Darker
thumbnail buttons to choose from
in section #3.

5 Click the same button again or click a
different button.

Repeated clicks of the same button intensify
the effect.

Click different buttons to get a unique,
combined effect.

6 Drag the Amount slider.

Increase or Decrease the amount of change
applied by the button(s) you click.

7 Click OK.

7

5

6
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The changes seen in the After thumbnail are
now applied to your image.

Note: You can click the Undo or Reset buttons to
start over without closing the dialog box.
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Replace 
a Color 
I n addition to correcting a color cast or adjusting the

amount of one or more colors in an image, you can
also entirely replace a color using Elements’ Replace

Color dialog box. The Replace Color dialog box is divided
into two main areas: Selection and Replacement. In the
Selection area, you use the eyedroppers to sample a color,
and then add to or subtract from that color until you have
the right color selected (displayed in the Results color
block). You can then drag the Fuzziness slider to determine

how many similarly colored pixels to include when the
replacement is made. You can also choose to display either
the image or the selected pixels in the Selection area
thumbnail, which can help you determine whether all of
the currently undesirable pixels will be included in the
replacement. After you have defined the color you want to
replace, just drag the Hue, Saturation, and Lightness sliders
until the Result color in the Replacement section of the
dialog box displays the color you want.

4

5

3

•

1 Click Enhance, Adjust Color.

2 Click Replace Color.

The Replace Color dialog box opens.

3 Click the first Eye Dropper button ( ).

4 Move your mouse onto the image window.

You may want to move the dialog box so that
the entire image window is visible.

Your mouse pointer turns into an eyedropper.
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Replace a Color

5 Click on a spot that represents the color you
want to replace.

• Check here to verify the color you want to
replace. 

6 Click the Add to Sample and/or Subtract from
Sample eyedroppers and then click within the
image to respectively include or exclude pixels
of the sampled color.

The Color block changes to a different shade
of the first color you selected.
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Why would I use the Fuzziness slider, or
increase the Fuzziness value?

If you want to replace, for example, the
blue in the sky with a gray color, or change
the red and gold leaves on an autumn tree
to green, you may want to reduce the
Fuzziness so that you do not include other
blue or red/gold items in the image. If you
want to change more of the pixels than the
eyedroppers select, you can raise the
Fuzziness level to include more pixels in the
replacement.

How do I choose between Selection and
Image view?

Generally, you want to use Selection view,
which shows (in white) the pixels that will
be replaced when you click OK. The image
window shows your photo, and previews
the changes in color as you make your
selections.

7 Drag the Fuzziness slider until the Selection
includes all the pixels you want to replace.

8 Drag the Hue slider until the Result color
block is the shade with which you want to
replace the unwanted color.

9 Adjust the Saturation and Lightness sliders
as needed.

• Refer to the Result color block to make
sure you have the right color for your
replacement.

0 Click OK.

7

8 •

0

9

253

Repairing, Restoring, and Retouching chapter 10

The pixels matching the Color block are
replaced with the color in the Result block.
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Equalize 
Colors
Y ou can use the Equalize filter to redistribute the brightness

values in your image. This can lighten an overly dark or gray
photo.

Photoshop Elements equalizes an image by finding the lightest and
darkest colors in the image and converting them to white and black. It
also redistributes the colors in between. Unlike some of the other filters
in Photoshop Elements, the Equalize filter does not offer any additional
settings you can control. The filter is applied immediately to the image
or selection.

If you make a selection before performing the command, Elements asks
whether you want to equalize only the selection or equalize the entire
image based on the selection.

Adjustments Equalize
3

1
2

1 Click Filter.

2 Click Adjustments.

3 Click Equalize.
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Equalize Colors

Photoshop Elements equalizes the colors
in the image.

Can I apply the filter to multiple
layers?

You can apply the various filters to
individual layers in your photo, or to
multiple layers. You might utilize
multiple layers to build up an effect;
then use the different layer blending
modes to blend the filter effects. See
Chapter 6 to learn more about
blending layers.
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Posterize
Colors
Y ou can reduce the number of colors in your image

using the Posterize filter, which can give a photographic
image a solid-color poster look. The Posterize filter allows

you to control tonal levels in a photo. The more levels you assign,
the more colors and tones appear in the image. The less levels
you assign, the less colors and tone appear in the image.

If you make a selection before performing the Posterize
command, you only affect the selected pixels. Similarly, if you
have a multilayered image, your adjustments only affect the
selected layer. See Chapter 4 to make a selection and Chapter 6
for more on layers.

Adjustments

Posterize...
3

1
2

54

1 Click Filter.

2 Click Adjustments.

3 Click Posterize.

The Posterize dialog box appears.

Posterize Colors
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4 Type the number of levels.

More levels mean more solid colors in the
resulting image.

Photoshop Elements posterizes the image.

5 Click OK.

Photoshop Elements applies the changes.

Can I apply the Posterize filter to a
black and white photo?

Yes. Since the filter adjusts for tonal
levels, you can use the Posterize filter to
remove grayscale tones from an image.
For example, if you use a small level,
such as 5, the image starts to look like a
very bad photocopy.
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Blur and Smudge 
Image Content 
T he Blur, Sharpen, and Smudge tools, which share a

single button in the toolbox, are used to soften
edges, make one part of the image blend with

another, and enhance the differences between pixel color
values so that details stand out more clearly. The pixels that
lay in the Blur tool’s path become similar, with even distinct
differences in color values coming closer together.
Smudging goes one step further, literally mixing adjacent

pixels as you drag your mouse. If you drag through a red
area into a blue area, the red smears into the blue. The
Smudge tool enables you to control the strength of the
smudged effect. The effects of all three tools are confined
to the path of your mouse as you drag through the image,
but you can control the size and intensity of the effect by
selecting the right brush preset and choosing an
appropriate Strength setting for the tools.

2

1

6

• 3

4 5

1 Click the Blur tool ( ).

The Blur tool options bar appears.

2 Click here and select a brush preset.

• Choose from hard, soft, and textured
brushes.

3 Set the Size of the brush.

When using a larger brush size, more pixels
are blurred in a single pass of the mouse.
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Blur Image Content

4 Click here and select a mode.

Normal is the default.

5 Click here to set the Strength.

A higher Strength value yields more dramatic
effects.

6 Drag through the image.

The content in the path of your mouse is
blurred in the active layer.
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What does the Finger Painting option do
for the Smudge tool?

If you have Finger Painting turned on, the
current Foreground Color is smudged into
the pixels through which you drag the
mouse.

When would I need the Use All Layers
option?

Turn this option on if you want the same
effect applied to all of your layers. For
example, if you want some content on one
layer to blend in visually with adjacent
content on another layer, select Use All
Layers so that the two edges blur together
as you drag over their common areas.

1 Click the Smudge tool ( ).

The Smudge tool options bar appears.

2 Click here and select a brush preset.

• Choose from hard, soft, and textured
brushes.

3 Click here and select the brush size.

A larger brush smudges more pixels in a single
pass of the mouse.

4 Click here and select a smudge mode.

2

1

6

• 3 4

5
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5 Click here and select a Strength value.

6 Click and drag in short strokes wherever you
want to smudge the content.

Content from your click point is smudged into
the adjacent pixels.

The size of the brush and the Strength setting
determine the result.

Smudge Image Content
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Blur an 
Image
Y ou can use the Blur filters to create a variety of

blurring effects in your photos. For example, you
can use a Gaussian Blur filter to obscure

background objects while keeping foreground objects in
focus. By diminishing a busy background, for example, you
can make the image look as if it has a short depth of field.
A short depth of field keeps the foreground subject in focus
while the background is out of focus.

You might blur away a background to eliminate unwanted
clutter behind the subject, or to emphasize the subject of

your photo. You can also use the technique in an artistic
way to blur away people surrounding your subject.

When blurring an image with a filter, you can control the
radius value, which determines how far the filter searches
for dissimilar pixels to create the blur. You can set a specific
amount for the radius value, or you can drag the slider to
set an amount. Like many of the filters, the Gaussian Blur
filter allows you to preview the effect before applying it to
the image.

Blur

Gaussian Blur...

Layer 1

•

4

6

5

1

2

3

1 Select the layer to which you want to
apply the filter.

Note: For more about layers, see Chapter 6. 

Note: To apply the filter to just part of your
image, you can make the selection with
a selection tool. For more on selection
tools, see Chapter 3.

2 Click Filter.

3 Click Blur.

4 Click Gaussian Blur.
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Blur an Image

The Gaussian Blur dialog box appears.

• A small preview area displays a
preview of the filter’s effect.

5 Click – or + to zoom out or in.

6 Click the Preview option to preview
the effect in the main window 
( changes to ).
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How do I add directional blurring to an
image?

You can use directional blurring to create
the illustion of movement in a photo, even
if the subject is standing perfectly still.
To apply the effect, click the Filter menu and
click Blur, Motion Blur. In the Motion Blur
dialog box click and drag the Angle dial to
define the direction of the blur. You can click
and drag to adjust the amount of blur;
then click OK to apply the filter.

What does the Radial Blur do?

Unlike the Motion Blur, which blurs pixels in
a linear fashion, you can use the Radial Blur
filter to blur pixels in a circular fashion. You
can use a Radial Blur to create a spinning
effect for the subject. You can find the Radial
Blur listed on the Filter menu in the Blur
category.

7 Drag to control the amount of blur added.

In this example, boosting the Radius value
increased the amount of blur.

8 Click OK.

8

7
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Photoshop Elements applies the filter.

In this example, the background layer is
blurred while the foreground remains
unchanged.

Experiment with the other Blur filters to create
other kinds of blurring effects in your image.

17_578782 ch10.qxd  3/21/05  11:32 AM  Page 259



Turn an Image 
into a Painting
Y ou can use many of Photoshop Elements’ Artistic

filters to make your image look as if you created it
with a paintbrush or other art media. The Dry

Brush filter, for example, applies a painted effect by
converting similarly colored areas in your image to solid
colors. 

The Artistic category, just one of the many categories of
filters available in Photoshop Elements, offers 15 different
artistically styled filters you can apply. Each one creates a
different effect in your image. For example, the Watercolor

filter turns your photograph into a watercolor painting.
Using the filter’s settings, you can control the detail of the
brush strokes, the intensity of shadows, and the texture of
the painting. Depending on the settings you make, the
effect may be subtle, or quite discernable.

To apply the filter to just part of your image, you can make
the selection with a selection tool. See Chapter 3 to use
selection tools.

Be sure to experiment with the other Artistic filters available
to simulate fresco style, colored pencils, and pastels.

Artistic

Filter

Watercolor...

2

Background

2

4

1

6

5

•

3

1 Select the layer to which you want to apply
the filter.

Note: For more about layers, see Chapter 6. 

In this example, the image has a single
Background layer.

2 Click Filter.

3 Click Artistic.

4 Click an effect.

The Filter Gallery dialog box appears.
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Turn an Image into a Painting

5 Make adjustments to the filter’s settings to
fine-tune the effect.

With some filters, you can preview the effect
before assigning it to the image. Click – or +
to zoom out or in.

6 Click OK.
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How do I make my image look like a sponge
painting?

You can use the Sponge filter to reduce details and
modify the image’s shapes. Simply follow steps 1 to
4 in this section, but select Sponge in step 4. In the
Sponge dialog box, click and drag the slider to
define the size and contrast of the sponge strokes.
When the preview shows the effect you want, click
OK to apply the filter to your photo.

Are there other ways to add painterly effects to
a photo?

Yes. You can polish a portrait with a few quick
painting effects to give your image a painterly feel.
With a portrait, you can easily add painterly effects
to the subject’s eyes. Use the Dodge tool, for
example, to whiten the eyes; then increase the color
saturation of the iris. Use the Brush tool to draw a
white glimmer in the eye and clone away any
distracting light specks. Lightly paint a dark line
around the underside of the iris; then finish off with
a dot of red on the inner tear duct.

Photoshop Elements applies the filter.

In this example, the Watercolor filter is
applied.
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In this example, the Cutout filter is applied.

You can use the other types of filters available
in the Filters menu to create different kinds of
special effects in your photos.
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Turn an Image 
into a Sketch
T he Sketch filters add outlining effects to your

image. The Sketch category is just one of the many
categories of filters available in Photoshop

Elements. You can find 14 different sketch styles you can
apply. Each one creates a different effect in your image. The
Charcoal filter, for example, makes an image look as if you
sketched it using charcoal on paper. 

You use the foreground as the charcoal color and the
background as the paper color. Changing these alters the
filter’s effect. See Chapter 9 to adjust color.

Using the Charcoal filter’s settings, you can control the
thickness, detail, and the balance of light and dark tones.
Depending on the settings you make, the effect may be
subtle, or quite discernable in the photograph. Every time
you make an adjustment to a setting, the preview area
displays the effects on the image.

To apply the filter to just part of your image, you can make
the selection with a selection tool. To use the selection
tools, see Chapter 3.

Sketch

Charcoal...

4

Background

4

6

1

5

2

3

1 Select the layer to which you want to apply
the filter.

Note: For more about layers, see Chapter 6. 

In this example, the image has a single
Background layer. 

2 Click Filter.

3 Click Sketch.

4 Click Charcoal.
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The Charcoal dialog box appears.

A window displays a preview of the filter’s
effect.

5 Click – or + to zoom out or in.

6 Click and drag the sliders to control the
filter’s effect.
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What does the Photocopy filter do?

The Photocopy filter converts your image’s
shadows and midtones to the foreground
color and highlights to the background
color to make the image look a photocopy.
To apply the filter, follow steps 1 to 4 in
this section, selecting Photocopy for step 4.
In the Photocopy dialog box, click and
drag to control the detail and darkness
of the colors. Click OK and Photoshop
Elements applies the filter.

Is it easier to apply a filter using the
Filter Gallery or the Filter menu?

Either method produces the same results.
If you use the Filter Gallery, however, you
can quickly access other filters to apply.
The Filter Gallery displays thumbnail
examples of each filter effect, so you can
see what your photo might look like before
trying out the filter. To view the gallery at
any time, display the Styles and Effects
palette.

In this example, the thickness of the charcoal
strokes is increased.

The Light/Dark Balance setting is also
increased to darken the image.

7 Click OK.

7
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Photoshop Elements applies the filter.
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Add Noise 
to an Image
F ilters in the Noise menu add or remove graininess in

your image. For example, you can add graininess to
a photo with the Add Noise filter to make the image

look like it was shot using high-speed film. You can also use
this filter to help blend edits in a photo. The Noise category
offers five filters you can experiment with to create different
effects in your photos. The Noise filters work to add or
remove pixels with randomly distributed color values to
create different effects.

With the Add Noise filter, you can control the amount of
noise added to an image, as well as a distribution mode.
The Uniform distribution creates a very subtle effect, while
the Gaussian distribution results in a speckled appearance. 

To apply the filter to just part of your image, you can make
the selection with a selection tool. To use the selection
tools, see Chapter 4.

Be sure to experiment with the other Noise filters available
to see what other photo effects you can create.

Noise Add Noise...

Background
1

6

5

4

2

3

1 Select the layer to which you want to apply
the filter.

Note: For more about layers, see Chapter 6. 

In this example, the image has a single
Background layer. 

2 Click Filter.

3 Click Noise.

4 Click Add Noise.
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The Add Noise dialog box appears displaying
a preview.

5 Click – or + to zoom out or in.

6 Click the Preview button to preview the effect
in the main window ( changes to ).
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What does the Monochromatic
setting in the Add Noise dialog
box do?

If you click Monochromatic 
( changes to ), Elements
adds noise by lightening or
darkening pixels in your image.
Pixel hues stay the same. At high
settings with the Monochromatic
setting on, the filter produces a
television-static effect.

How do I control the preview
of my filter?

In the Add Noise dialog box,
you can click the Minus (–) or
Plus (+) buttons below the
preview area to change the
preview’s magnification setting.
For example, you may want to
zoom out to see more of the
photo, or zoom in for a closer
look.

Can I add a filter to a
background layer?

Yes. Adding filters to background
layers allow you to create a
variety of textures behind the
subjects of your photos.

7 Click and drag the Amount slider ( ) to
change the noise.

8 Click here to select how you want the noise
distributed ( changes to ).

Uniform spreads the noise more evenly
than Gaussian.

In this example, the Amount value is
increased.

9 Click OK.

Photoshop Elements applies the filter.

9

7

8
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Pixelate 
an Image
T he Pixelate filters divide areas of your image into

solid-colored dots or shapes. The Crystallize filter,
one example of a Pixelate filter, re-creates your

image using colored polygons. The Pixelate filters work by
clumping pixels of similar color values together.

The Pixelate category, just one of the many categories
of filters available in Photoshop Elements, offers seven
filters you can apply. Each one creates a different effect in
your image. For example, you can use the Crystallize filter
to make your photo look like you captured the picture
through glass, or you can use the Mosaic filter to turn

your photo into a tiled mosaic. Depending on the filter
you select, you can use the various options to control the
degree of the effect. For example, when you apply the
Crystallize filter, you can use the filter’s Cell Size setting to
control the detail of the pixelating effect. Depending on the
value you set, the effect may be subtle, or quite discernable.

To apply the filter to just part of your image, you can make
the selection with a selection tool. To use the selection
tools, see Chapter 3.

Be sure to experiment with the other Pixelate filters
available to see what other photo effects you can create.

Pixelate
Crystallize...

Background 1
4

5

2

3

1 Select the layer to which you want to
apply the filter.

Note: For more about layers, see Chapter 6. 

In this example, the image has a single
Background layer.

2 Click Filter.

3 Click Pixelate.

4 Click Crystallize.
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The Crystallize dialog box appears
displaying a preview of the filter’s effect.

5 Click – or + to zoom out or in.
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What does the Mosaic filter do?

The Mosaic filter converts your image to a
set of solid-color squares. You can control
the size of the squares in the filter’s dialog
box. To apply the filter, click the Filter
menu, and click Pixelate, Mosaic. In the
Mosaic dialog box, click and drag the slider
to specify the mosaic square size. Click OK
to apply the filter. You can always preview
the effect before applying it to the photo.

Does Photoshop Elements keep track of
the filters I use the most?

By default, Elements lists the last filter you
used at the very top of the Filter menu. If
you want to use the same filter with a new
photo, using the exact same value settings,
simply select the filter name. If you prefer
to fine-tune the values for the new photo,
you must select the filter from the Filter
menu categories instead.

6 Drag to adjust the size of the shapes.

The size can range from 3 to 300.

In this example, the Cell Size has been slightly
increased.

7 Click OK.

7

6
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Photoshop Elements applies the filter.
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Emboss 
an Image
Y ou can achieve the effect of a three-dimensional

shape pressed into paper with the Emboss filter.
You may find this filter useful for generating

textured backgrounds.

In addition to an embossing effect, the Stylize filter
category also includes filters for producing painted and
impressionistic effects. The Stylize filters work by displacing
pixels and heightening contrast. For example, the Wind
filter creates horizontal lines in a photo, making it look as if
the details of the image are blowing away in the wind. The

Glowing Edges filter adds a neon glow to the edges of color
in your photo. All of the Stylize filters include options for
controlling the appearance of the effect.

To apply the filter to just part of your image, you can make
the selection with a selection tool. To use the selection
tools, see Chapter 3.

Be sure to experiment with the other Stylize filters available
to see what other photo effects you can create. You can
choose from nine Stylize filters, and each one creates an
entirely different effect on your photo.

Stylize

Filter

Emboss...

43

Background

•

1

2

43

5
6

1 Select the layer to which you want to
apply the filter.

Note: For more about layers, see Chapter 6. 

In this example, the image has a single
Background layer.

2 Click Filter.

3 Click Stylize.

4 Click Emboss.
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Emboss an Image

The Emboss dialog box appears.

Photoshop Elements displays a small
preview of the effect.

5 Click – or + to zoom out or in.

6 Type an angle to specify in which
direction to shadow the image.

• You can also click and drag the angle
dial to set an angle.
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Do I have another way to create an embossed
effect in an image?

Yes. You can use the Bas Relief filter to get a similar
effect. It creates a two-toned embossed effect by
reducing an image to the current foreground and
background colors. To apply the filter, follow steps 1
to 4 in this section, clicking Sketch in step 3 and Bas
Relief in step 4. In the Bas Relief dialog box, click
and drag the slider to control the detail. You can
click and drag the slider to control the smoothness
of the effect. Click OK to apply the filter.

What kind of effects can I create with the layer
styles?

You can use the layer styles, found in the Styles and
Effects palette, to add effects to an entire layer. The
styles include borders, such as bevels, drop
shadows, and more. You can view the layer styles in
the Styles and Effects palette or through the Layer
menu. To learn more about working with palettes in
Photoshop Elements, see Chapter 1.

7 Drag to the desired pixel height.

You can specify a height from 1 to 10 to set
the strength of the embossing.

8 Drag to set the amount of embossing
detail.

You can specify an amount from 1 to 500 to
set the number of edges the filter affects.

9 Click OK.

9

8

7
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Photoshop Elements applies the filter.
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Sharpen Image 
Content 
T he Sharpen tool augments the differences between

color values of the pixels in its path. This results in
more detail, crisper edges, brighter lights, and

deeper shadows. You can apply the Sharpen tool in a subtle
way, leaving its Strength setting low (50% or less), and by
using only one layer. You can also make a selection before
using the tool, thus confining the Sharpen tool’s effects to
that selected area. The options bar contains a Use All Layers

option, which you can leave off if you want to sharpen only
the content of a single layer. Be careful not to drag the
Sharpen tool repeatedly over any area, even if the tool is set
to a low Strength. If you do drag over and over, the results
can be too drastic — brightly colored pixels appear, the
result of Elements creating too much of a difference
between adjacent pixels. 

1

2 3

4

Normal

1 Click the Sharpen tool ( ).

The Sharpen tool options bar appears.

2 Click here and select a brush preset.

Choose from hard, soft, and textured brushes.

3 Click here and drag the slider to set the brush size.

A larger brush sharpens more pixels in a single
pass of the mouse.
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Sharpen Image Content

4 Click here and select a Mode.

Normal is the default.

Note: See Appendix B to learn about all the Elements
modes and their effects.
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Does the Sharpen tool work the same
way as the Sharpen filter?

Yes, in that it heightens the differences
between adjacent pixels, making all
the pixels stand out from one another.
However, the Sharpen filter does not
rely on your mouse and your eye-hand
coordination, and applies the results
more uniformly across an entire layer
or within a selection.

How do I know what Strength to use?

If you need just a little sharpening —
just enough to get rid of any blurriness
or a lack of definition along edges —
leave the Sharpen tool set to its default
of 50% Strength. If that gives you too
much sharpness, in the form of too
many bright pixels, reduce the
Strength value to 30% and try that.
Like most tools that are adjustable, you
may need to experiment to find the
perfect results for the image at hand. 

5 Click here and drag the slider to set the
Strength of the Sharpen tool.

A higher Strength value produces more
sharpening in a single pass of the mouse.

6

5
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6 Drag through the image.

The image is sharpened wherever you
dragged the mouse.
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Remove 
Red Eye
Y ou can use Elements’ Red Eye Removal tool to eliminate the unnatural

glow (known as “red eye,” although the glow is not always red) that
appears in the eyes of people or animals who were too close to the

camera’s flash. With this tool, you set the size of the pupil, relative to the iris
for the eye in question (the default setting is 50%), and tell Elements how
much darker the pupil should be. The percentage you choose depends on the
severity and brightness of the glow and the degree of darkness of the iris. If
your subject has dark brown eyes, you would want to increase the Darken
Amount to 75% or more so that a dark pupil stands out in the middle of the
eye. If your subject has very light eyes, a lower percentage will probably look
more natural. When you are ready to fix the image, just clicking the mouse on
the glowing pupil removes the red eye. If your first attempt does not give you
the result you hoped for, simply click again to reapply the tool’s settings and
increase the darkening effect.

1

5

2 3

4

1 Click the Red Eye Removal tool ( ).

The Red Eye Removal tool options bar
appears.

2 Click here and select the pupil size.

3 Click here and select the darken amount.
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Remove Red Eye

4 Click your mouse in the center of where the
pupil should appear.

The mouse pointer turns into cross hairs ( ).

The pupil is darkened, and the red is gone.

5 Repeat in the other eye as needed.

How do I fix red eye that has
obscured not just the pupil
but the entire iris as well?

This may require some more
complex retouching, and the
creation of an iris where one
no longer exists. You can use
the Elliptical Marquee to select
the iris (using the Subtract
from Selection option to carve
out an ellipse for the pupil in
the iris’s center) and then
apply a fill color with the Paint
Bucket or Paint Brush. You
could also use Color Variations
(discussed earlier in this
chapter) to lighten and then
add color to the selection.
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Remove a 
Color Cast
Y ou can fix a color cast — a shift in color that turns part or all of an

image yellow, green, or red, which are the most common casts —
using the Color Cast command in the Enhance, Adjust Color

submenu. Although other commands and tools such as Color Variations or
Hue/Saturation enable you to eliminate a color cast, this command is
intended specifically for that purpose. When you choose Color Cast from
the submenu, a dialog box advises you to click the eyedropper tool and
click on a spot in the image that should be black, white, or gray. When
you sample one of those spots, Elements automatically adjusts the overall
colors in the image, removing the color cast. When using the Color Cast
command, you are not restricted to one click of the Eyedropper. If you see
(in the preview in the image window) that the cast is not completely
gone, or that the colors are still not “right,” you can click yet another spot
in the image and Elements readjusts the colors again. You can continue to
click dark, light, or midrange spots until you achieve the results want.

3

1

4

1 Click Enhance, Adjust Color.

2 Click Remove Color Cast.

The Remove Color Cast dialog box appears.

Remove a Color Cast
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3 Click a black, white, or gray spot in your
image.

The color cast is adjusted. 

Note: If the color cast remains, or an undesirable
change in color results, click another black,
white, or gray spot in the image and be
prepared to keep clicking alternate spots
until the desired results are achieved.

4 Click OK.

I get a good result only when I
click a white spot, not when I
click a black or gray spot. Why?

It all depends on the colors in
your image and the spot you
choose to click on with the
Color Cast eyedropper. If the
image does not contain a very
dark color, or if you click on
what you think is a midrange
color (usually gray), but do not
click on a spot that provides the
input the Color Cast settings
need to make the right
adjustments, your color cast may
remain, or may even change to,
an even less desirable hue.
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Boost Colors with the
Multiply Blending Mode
Y ou can use the Multiply blending mode to

strengthen and intensify colors in your photo. For
example, if environmental light and chemicals have

faded your color Polaroid over time, you can give the image
a color boost with the Multiply blending mode. Professional
photographers also use this technique to create an instant
color boost in images. 

For best results, assign the Multiply blending mode to an
Adjustment layer before applying the mode. By duplicating
your image and then applying a blending mode, you can

stack brightness levels in the image layers to increase color
strength. Keep in mind, however, that boosting colors also
boosts the darker colors in your image.

Boosting colors can really make a photo pop with vibrancy.
You might also apply this popular blending mode on any of
your photos just to see what kinds of color improvements
you can create. You can also control the intensity of the
blending mode by adjusting the layer’s opacity level. After
you apply the blending mode, you can use the Photoshop
Elements tools to make adjustments to any overly dark
areas in the image.

Multiply

Background copy

2

1
•

1 Duplicate the layer you want to adjust.

• The fastest way to duplicate the layer is to
drag and drop the layer over the New
Layer button.

Note: See Chapter 6 to read more about layers.
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2 Click here and select Multiply.
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How can I boost an area of pixels rather
than an entire layer?

Start by selecting the pixels you want to
boost using a selection tool; then click the
Layer menu and click New, Layer via Copy.
Now apply the Multiply blending mode to
the copied layer to boost only the selected
pixels in the image. See Chapter 3 to learn
more about using the various selection tools
in Photoshop Elements.

Can I also use the Sponge tool to boost
color?

Yes. You can use the Sponge tool, set to
Saturate mode, to boost color over any area
you paint over on a photo. For example,
you might want to boost the color of a
subject’s hair or eyes, or make the petals of
a flower much more vibrant than they
originally appear in the photo. You can also
control the size of the Sponge tool as you
drag it on the pixels you want to change.

Photoshop Elements applies the Multiply
blending mode.

3 Click here and then click and drag to
lessen the effect.

3

•
•
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• If an area of the layer is too dark,
you can click and drag the Eraser tool
( ) to erase the Multiply mode over
an area.

Note: For more about the Eraser tool, see
Chapter 8.

• In this example, the Eraser tool is
applied to the darker pixels here to
lighten the area.
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Turn a Color Photo
into Black and White
Y ou can change the image mode to turn a color

photo into a black and white photo. Elements
accomplishes this by converting the colors

to grayscale. You may want to make a picture black and
white to create a dramatic effect or to publish the photo
in a non-color newsletter or brochure. For example, you
might turn a series of family snapshots into black and
white images, and then display them on a wall or mantel to
create a cohesive design.

The Grayscale command converts the colors in an image to
gray values. It does this by assigning equal red, green, and
blue values to every pixel. Just because the color values
change, the lightness values do not. This produces shades
of gray in the image. 

When you make a color photo into grayscale, the change
is permanent. For this reason, you may want to copy
the image file before making the change so the original
file is still intact with full color. See Chapter 2 to read how
to save files.

Mode
Grayscale

32

1

•

1 Click Image.

2 Click Mode.

3 Click Grayscale.
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Turn a Color Photo into Black and White

• If your image has multiple layers, you
may need to flatten the layers first
before proceeding. Click Flatten.

Note: For more about flattening images, see
Chapter 6.

Photoshop Elements applies the change.
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Can I remove color from just one
color channel?

Yes. You can leave your image in
RGB color mode and just desaturate
the color channels using the
Hue/Saturation dialog box. Click
the Enhance menu; then click Adjust
Color, Hue/Saturation. Use the 
drop-down box to click the color
channel you want to edit; then drag
the Saturation slider to the left.
Click OK and Photoshop Elements
desaturates the color channel.

What does the Remove Color
command do?

The Remove Color command
achieves the same effect as Grayscale
command. However, rather than
permanently turn a color photo into
a black and white photo, the Remove
Color command affects the image
mode. Photoshop Elements still reads
the image file as an RGB file. To apply
the Remove Color command, click
Enhance, click Adjust Color, and then
click Remove Color.

• If your image is one layer, Photoshop
Elements displays a prompt box asking if
you want to discard color information or
not. Click OK.

•
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Photoshop Elements applies the change.
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Add Color to a 
Black-and-White Photo
Y ou can add color to a black-and-white photo using

any of the painting tools. Adding a little bit of color
can really enhance an old black-and-white image.

You must first turn the image into an RGB Color image.
Color you add to the photo does not look quite the same as
a full color photo; however, you can use bits of color to
spruce up the image. For example, you can add color to a
baby’s cheeks or to articles of clothing. You can use this
technique to create some very artistic and dramatic looks
for an image, such as painting a single rose in a bouquet
red to stand out.

When you turn a black-and-white photo into an RGB color
photo, the change is permanent. For this reason, you may
want to copy the image file before changing image modes
so that the original file is still intact in its black-and-white
state. For best results, always perform color changes on
duplicate or adjustment layers. See Chapter 2 to read how
to save files or see Chapter 6 for more about layers.

Mode

RGB Color

Background copy

3

4

9

1

5 8 7

6

2

•

1 Click Image.

2 Click Mode.

3 Click RGB Color.

• If your image has multiple layers, you
may need to flatten the layers first
before proceeding. In the prompt box
that appears, click Flatten to continue.
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Add Color to a Black-and-White Photo

4 Duplicate the Background layer.

Note: See Chapter 6 for more on how to work
with layers.

5 Click the Brush tool ( ).

6 Click the Foreground color.

7 In the Color Picker dialog box, click a
color range.

8 Click a color. 

9 Click OK.
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How do I tone down a layer color?

You can change the layer opacity in the Layers
palette to make the color more transparent. Start by
clicking the layer containing the color you want to
edit. Next, click and drag the Opacity slider at the
top of the Layers palette. Drag to the left to make
the layer less opaque or drag to the right to make
the layer more opaque. Photoshop Elements
automatically adjusts the color as you drag. See
Chapter 6 to learn more about working with layers.

Which tool works best for adding color to a
black-and-white photo?

You can use any of the painting and drawing tools,
but the Brush tool is the best place to start. You can
use it to brush broad strokes or tiny lines of color
onto your photo. You can control the size of the
brush as well as the opacity. You can also turn on
the airbrush option for even softer painting effects.
See Chapter 8 to learn more about drawing and
painting in Photoshop Elements.

0 Click and drag to paint the color on the
photo.

Photoshop Elements applies the change.

• You can set a lower Opacity level to make
the painting effect subtler.

• You can also use the Paint Bucket tool to fill
in color in a selected group of pixels in one
quick click.

•

0

•
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This example shows color added to articles of
clothing in the image.

17_578782 ch10.qxd  3/21/05  11:32 AM  Page 279



Apply Filters to Enhance
Image Quality
F ilters are groups of special effects that apply

changes to color, light, shape, and content within
an image. Some filters mimic artistic media —

painting, drawing, sketching, or textiles like fabric or mosaic
tile — and others mimic natural and man-made substances
or coatings like glass, chrome, or plastic wrap. You can also
apply filters to distort your image, to soften it, or to
increase the level of detail within the image. You can apply
filters to the entire image, to a particular layer, or to a
selection within a layer. You can apply the same filter

repeatedly, increasing the intensity of its effect with each
application; or you can apply combinations of filters to
achieve specialized results. The Filter Gallery makes
previewing and applying filters easy, and displays samples
and a full set of options for each filter. You can also use the
Filter menu and its submenus to apply filters. When you
make a selection from the submenus, a dialog box for the
selected filter appears; or, if the filter has no options
available, Elements directly applies the filter to the image or
selection, with no further input required from you.

2

4
3

•

•

•

•

1 Click Filter, Filter Gallery.

The Filter Gallery opens.

• The active image appears in a preview
window.

• Click these buttons to zoom the image
preview in or out.

• Buttons for each filter group/category
appear here.
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Apply Filters to Enhance Image Quality

2 Click a filter category.

3 Click a filter thumbnail.

The filter you clicked is applied to the image
preview.

• Filter options display here.

4 Click here to display a text list of all the
available filters, regardless of category.
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Is there any difference between
using the Filter Gallery and the
Filter menu?

No, not in terms of the filters’
effects on your image or how
you access each filter’s options.
The benefit of the Gallery is that
you can see a thumbnail sample
of each filter, which can be
helpful when filter names are
not descriptive of their effects,
or if you are not sure what filter
to use.

How can I reapply the last filter
I used, with the exact same
settings?

The Filter menu’s first command
displays the name of the last
filter used, along with a
keyboard shortcut for reapplying
that filter. If you are using
Windows, the shortcut is Ctrl+F;
if you are on a Mac, press
Command+F. 

Can I create my own custom
filters?

Yes and no. You can create a
custom filter by applying filters
in combinations to achieve
specific results. On the other
hand, you cannot save these
filter combinations for future
use; you can only repeat them if
you make note of your settings
and the order in which you
applied the filters. The best way
to devise special, custom filters
is to experiment and test your
results until you get the desired
effect.

1 Click the filter category for the filter you want
to apply.

2 Click the desired filter’s thumbnail.

Elements applies the selected filter to the
image preview.

• Options for the selected filter appear here.

4 Make any desired adjustments to the filter’s
options.

Drag sliders, turn options on or off, and make
choices from lists.

5 Click OK.

1

2

5

•4

281

Repairing, Restoring, and Retouching chapter 10

Elements applies the filter to the image in the
image window, and the Filter Gallery closes. 

Apply a Filter from the Gallery
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Liquify an 
Image
W ith the Liquify dialog box, you can warp, swirl,

shrink, expand, move, and otherwise distort
your image. The dialog box displays a preview

of the active image (or a portion of it, if you make a
selection before opening the Liquify dialog box), and you
can zoom in on the preview to make detailed distortions.
You can also access the Hand tool to pan within an image
that does not entirely fit within the preview window. For
each button on the far left-hand side of the Liquify dialog
box, there is a set of options on the right-hand side: Brush

Size, Brush Pressure (working much like the Strength option
for the Smudge tool), and Turbulent Jitter (which
determines how smoothly the liquify distortion is applied in
the path of your mouse). You can use any combination of
the tools in the dialog box, tweaking each one and
applying the effect to as much or as little of the image as
desired. Based on what you see in the preview window as
you apply the tools, you can click Revert to start over, or
OK to apply the effect to your image.

1

2

4

3

•

Distort

Liquify...

1 Click Filter.

2 Click Distort.

3 Click Liquify.

The Liquify dialog box appears.
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Liquify an Image

A preview of the image appears.

• Click here to zoom in or out as needed.

4 Click a tool.

This example shows the Twirl Counter
Clockwise tool.

The Tool Options offer the ability to customize
the effects of the tool.

5 Click and/or drag within the image preview.

The tool distorts the image, based on its
purpose and settings.
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Nothing happened when I
dragged the Twirl tool. Why?

Some of the Liquify tools work
best when you click and hold
down the mouse button on a
single spot in the preview. The
Twirl, Pucker, and Bloat tools
work when you click (and
continue to click, to intensify
the effect) on a single spot in
the image. You can affect more
of the image with that single
click by defining a large brush
size before using the tools.

Should I use the Reconstruct
tool or Revert if I want to put
the preview back to its original
state?

The Revert button literally reverts
the image to the state in which
it appeared before you applied
any of the Liquify tools. The
Reconstruct tool undoes specific
distortions based on where you
drag the mouse and how you
drag it, often resulting in uneven
results (and sometimes displaying
partial remains of the previously
applied distortions). The
Reconstruct tool is more effective
as a tool for reducing overzealous
use of another Liquify tool,
perhaps by untwirling something
slightly, or by reducing the
degree of distortion achieved
with the Warp tool.

How does the Reflection tool
work?

The Reflection tool pulls the
pixels from just outside the
path of your brush into the
brush path and turns them into
a distorted mirror-image of
themselves. This can be used to
duplicate content within the
image — just drag next to what
you want to mirror, and a
reflection is created in the path
of the mouse. Bear in mind that
what was in the path of the
mouse is replaced by what is
reflected.

• To undo the effects of the tool, click Revert.

6 Repeat steps 4 and 5 as desired.

7 Click OK.
•
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Elements applies the distortion to the image
in the image window.
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Remove Dust 
and Scratches
Y ou can add slight blurring to your image to remove

extraneous dust and scratches with the Dust &
Scratches filter. This can help improve scans of old

photographs. You can use the Elements filters to change the
appearance of your photographs. Each filter creates a
specific type of effect. The Dust & Scratches filter is part of
a group of filters in the Noise category designed to add or
remove pixels with randomly distributed color values. In the
case of the Dust & Scratches filter, the effect is to remove
problem areas in a photo. The Dust & Scratches filter works
by reducing visual noise by changing dissimilar pixels,
allowing you to blend selections into the surrounding pixels.

To apply the Dust & Scratches filter, you must first target
specific spots on your image that need correcting, such as a
scratch or a dust spot. When you apply the filter, you can
control the radius and threshold settings. The radius setting
controls what size speck you consider as dust or a scratch in
the image. The threshold setting controls how much the
pixels need to differ from their surrounding pixels in order
for Elements to consider it a dust speck or a scratch.

Filter

Noise

Dust & Scratches...

Layer 1

•

3

5

7
6

1

4

2

1 Select the layer to which you want to apply
the filter.

2 With a selection tool, select an area that has
dust and scratches.

Note: For more about layers, see Chapter 6. To use
the selection tools, see Chapter 3.

3 Click Filter.

4 Click Noise.

5 Click Dust & Scratches.

The Dust & Scratches dialog box appears.
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Remove Dust and Scratches

• Photoshop Elements displays a small
preview of the effect.

6 Drag to control what size speck you
consider dust or a scratch.

7 Drag to control how much pixels you
consider dust or a scratch must differ from
their surroundings.
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What does the Dust & Scratches filter do to
areas of an image that do not have dust or
scratches?

Although the intention of the Dust &
Scratches filter is to remove only minor
artifacts from an image, it still adds some blur
wherever you apply it. For this reason,
selecting areas that have dust and scratches
before applying the filter is best. This
prevents the filter from affecting details in an
image unnecessarily.

How do I adjust the preview in the Dust &
Scratches dialog box?

You can click the Minus or Plus buttons below
the preview area to change the preview
window’s magnification setting. For example,
you may want to zoom out to see more of
the photo, or zoom in to see a closer view of
the dust speck or scratch. You can also move
the mouse pointer over the preview area and
drag your view of the image to another area
of the photo.

• In this example, the Threshold value has
been decreased to remove all of the
selected dust.

8 Click OK.

8

•
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Photoshop Elements applies the filter.
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